January 18th, 2018
<table>
<thead>
<tr>
<th>CONTENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1        Tools and Analyses ........................................................................................................3</td>
</tr>
<tr>
<td>1.1      Convert multiple configurations to non-sequential mode (Professional and Premium editions) ... 3</td>
</tr>
<tr>
<td>1.2      Convert tolerance data to non-sequential mode (Professional and Premium editions) .............. 5</td>
</tr>
<tr>
<td>1.3      Increase sampling density of Physical Optics Propagation (Professional and Premium editions) .. 7</td>
</tr>
<tr>
<td>1.4      Test a new feature experiment (all editions) ......................................................................... 9</td>
</tr>
<tr>
<td>2        Usability ................................................................................................................................10</td>
</tr>
<tr>
<td>2.1      Right-click to ignore and hide non-sequential objects (Professional and Premium editions) ..... 10</td>
</tr>
<tr>
<td>2.2      Save and load optimizer settings (all editions) ................................................................. 11</td>
</tr>
<tr>
<td>2.3      Plot auto-scaled field data (all editions) ............................................................................ 11</td>
</tr>
<tr>
<td>2.4      Extract archive files to source folder (all editions) ............................................................ 12</td>
</tr>
<tr>
<td>2.5      Compare archive file contents (all editions) ........................................................................ 13</td>
</tr>
<tr>
<td>2.6      View ABCD ray transfer matrix in the Prescription Data (all editions) .................................. 14</td>
</tr>
<tr>
<td>3        Programming .......................................................................................................................... 15</td>
</tr>
<tr>
<td>3.1      Run sequential tools with the ZOS-API (Professional and Premium editions) ......................... 15</td>
</tr>
<tr>
<td>3.2      Modify preferences with the ZOS-API (Professional and Premium editions) .......................... 17</td>
</tr>
<tr>
<td>3.3      Access more ray data with the ZRD Reader (Professional and Premium editions) ................... 19</td>
</tr>
<tr>
<td>4        Libraries and catalogs ........................................................................................................... 20</td>
</tr>
<tr>
<td>4.1      Materials (all editions) ........................................................................................................ 20</td>
</tr>
<tr>
<td>4.2      Coatings (all editions) .......................................................................................................... 22</td>
</tr>
<tr>
<td>4.3      IES Source Models (Premium edition) .................................................................................. 22</td>
</tr>
<tr>
<td>4.4      Radiant Source Models (Premium edition) ............................................................................. 23</td>
</tr>
<tr>
<td>4.5      Test plates (all editions) ....................................................................................................... 24</td>
</tr>
<tr>
<td>4.6      Stock lenses (all editions) ..................................................................................................... 25</td>
</tr>
<tr>
<td>4.7      Sentinel drivers (all editions) ............................................................................................... 26</td>
</tr>
<tr>
<td>5        Bug Fixes ................................................................................................................................. 26</td>
</tr>
<tr>
<td>6        Known Issues .......................................................................................................................... 27</td>
</tr>
</tbody>
</table>
1 Tools and Analyses

1.1 Convert Multiple Configurations to Non-Sequential Mode (Professional and Premium editions)

Work more efficiently by converting all your sequential configurations into one non-sequential file.

The Convert to NSC Group tool now supports the conversion of sequential Multiple Configuration Editor (MCE) operands. In previous versions of OpticStudio, the MCE operands were not retained during the conversion to non-sequential mode. Now, the Convert to NSC Group tool automatically converts each sequential MCE operand to its equivalent non-sequential operand.

![Figure 1.1a. A sequential zoom lens with three configurations](image1)

![Figure 1.1b. The same zoom lens converted to non-sequential mode](image2)
The following MCE operands are supported in the conversion to non-sequential mode:

- CONN
- COTN
- CRVT
- GLSS
- MOFF
- MTFU
- PRAM
- PRWV
- SDIA
- TEMP
- THIC
- WAVE
- WLWT

Some sequential MCE operands do not have an equivalent non-sequential operand, and therefore cannot be converted. OpticStudio replaces these sequential operands with the operand MOFF, which includes a description of the original operand.

During the conversion to non-sequential mode, source and detector objects are automatically added to represent the sequential OBJECT and IMAGE surfaces. If the sequential file includes multiple locations for these surfaces, the source and detector objects are positioned with several NPOS and NPAR multi-configuration operands. These non-sequential MCE operands ensure that each Source Ellipse is correctly aligned for each field, and that the detectors are correctly aligned for each image location. The Detector Rectangle objects are aligned with the centroid of the spot for each field, and the Detector Color object is aligned with the vertex of the sequential IMAGE surface.

Note: Thermal pickups cannot be modeled in non-sequential mode, and therefore are not retained during a conversion.

The Convert to NSC Group tool is located in OpticStudio on the File tab, in the Convert section.

*Figure 1.1c. The File tab with the Convert to NSC Group tool*

The Convert to NSC Group tool converts a range of surfaces in the sequential Lens Data Editor to a Non-Sequential Component surface, or converts the file to a new non-sequential system. To convert sequential MCE operands to the equivalent non-sequential operands, select the Convert file to non-sequential mode check box in the Convert To NSC Group dialog box.
The Multiple Configuration Editor and associated tools are located on the Setup tab, in the Configuration section.

1.2 CONVERT TOLERANCE DATA TO NON-SEQUENTIAL MODE (PROFESSIONAL AND PREMIUM EDITIONS)

Maintain design fidelity by retaining sequential tolerances for further analysis in non-sequential mode.

The Convert to NSC Group tool now supports the conversion of sequential Tolerance Data Editor (TDE) operands. In previous versions of OpticStudio, the TDE operands were not retained during the conversion to non-sequential mode. Now, the Convert to NSC Group tool automatically converts each sequential TDE operand to its equivalent non-sequential operand.
The following TDE operands are supported in the conversion to non-sequential mode:

- CMCO
- COMM
- SAVE
- SEED
- STAT
- TABB
- TEDX
- TEDY
- TETX
- TETY
- TETZ
- TIND
- TMCO
- TOFF
- TRAD
- TTHI

Some sequential tolerancing capabilities, including modeling surface tilts and surface irregularity, are not available in non-sequential mode. The associated TDE operands do not have an equivalent non-sequential operand, and therefore cannot be converted. Instead, the sequential TDE operand is replaced with the operand TOFF, which includes a description of the original operand.
Note: Flat surfaces with a sequential TFRN operand must be manually converted to the appropriate radius tolerance. Tilted and decentered groups of elements also need to be converted manually.

The Convert to NSC Group tool is located on the File tab, in the Convert section. (See Figure 1.1c.) The Convert to NSC Group tool converts a range of surfaces in the sequential Lens Data Editor into a Non-Sequential Component surface, or converts the file into a new non-sequential system. To convert sequential TDE operands to the equivalent non-sequential operands, select the Convert file to non-sequential mode check box. (See Figure 1.1d.)

The Tolerance Data Editor is located on the Tolerance tab, in the Tolerancing section:

![Figure 1.2c. The Tolerance tab with the Tolerance Data Editor button](image)

### 1.3 INCREASE SAMPLING DENSITY OF PHYSICAL OPTICS PROPAGATION (PROFESSIONAL AND PREMIUM EDITIONS)

Learn more about the optical systems you’re simulating by using extremely high sampling of a coherent beam propagation.

You can now significantly increase the sampling settings in the Physical Optics Propagation (POP) analysis by using the RunHighSamplingPOP method in the ZOS-API. The highest X- and Y-Sampling allowed in the POP settings in the user interface is 16,384 sampling points. The highest allowed using the ZOS-API is 1,073,741,824 sampling points.

![Figure 1.3a. The irradiance and phase results from a POP analysis of a lens array](image)
For most coherent beam simulations, the POP sampling settings in the user interface are sufficient (allowing up to 16,384 sampling points). Some optical phenomena, such as optical diffraction and transition radiation, require higher sampling densities. The simulation must capture very narrow high-intensity peaks without truncating the low-intensity tails, which requires high sampling densities. In this case, you can use the ZOS-API to override the sampling settings in the UI.

Note: A high sampling setting typically requires a significant amount of RAM.

The inputs for the RunHighSamplingPOP method include:

- `configFile` – The path to the POP configuration settings
- `xSampling` – The sampling override in the X-direction
- `ySampling` – The sampling in the Y-direction
- `outputTextFile` – The path to save the output file

For more information about the RunHighSamplingPOP method, see the ZOS-API Syntax Help file.
1.4 TEST A NEW FEATURE EXPERIMENT (ALL EDITIONS)
Get a sneak peak of what’s coming and help us refine a new feature.

The Zemax Lab includes a new feature experiment. This feature is likely to change before final implementation, and is not yet documented in the Help Files.

The Zemax File Collector automatically packages all the files needed to troubleshoot or report a potential bug to Zemax Support. Files that include potentially sensitive information are flagged and can easily be removed. The resulting ZIP file can be saved for reference, or sent as an email attachment to support@zemax.com.

Figure 1.4a. The settings in the Zemax File Collector
Feature Experiments is located on the Help tab, in the Zemax Lab section.

Figure 1.4b. The Feature Experiments menu is on the Help tab

2 USABILITY

2.1 RIGHT-CLICK TO IGNORE AND HIDE NON-SEQUENTIAL OBJECTS (PROFESSIONAL AND PREMIUM EDITIONS)

Set up non-sequential systems faster using new shortcuts on the right-click menu.

Objects in the Non-Sequential Component Editor (NSCE) can now be ignored and hidden in a single step using the Ignore and Hide Object setting on the right-click menu. Similarly, objects in the NSCE can be considered and shown in a single step using the Consider and Show Object setting on the right-click menu. To find these settings, right-click any object in the NSCE.

Figure 2.1a. The new settings (Consider and Show Object, and Ignore and Hide Object), are on the right-click menu of the NSCE. The Ignore and Hide Object option was used on the Detector Polar.

The Consider and Show Object option automatically changes the following settings in the Object Properties window:

- In the Type section, under Raytrace, it sets Rays Ignore Object to Never
- In the Draw section: it clears the Do Not Draw Object check box

Conversely, the Ignore and Hide Object option automatically makes the following changes:
• In the Type section, under Raytrace, it sets Rays Ignore Object to Always
• In the Draw section: it selects the Do Not Draw Object check box

Note: The Rays Ignore Object setting is disabled for sources. Therefore, these two right-click options only turn on and off the "Do Not Draw" checkbox.

![Image](image1.png)

**Figure 2.1b.** The Type section of the Object Properties window includes the Rays Ignore Object setting. The options are Never, Always, and On Launch.

![Image](image2.png)

**Figure 2.1c.** The Draw section of the Object Properties window includes the Do Not Draw Object check box

### 2.2 Save and Load Optimizer Settings (All Editions)

**Ensure consistency when using custom optimization settings.**

You can now save settings, load settings from a previously saved setting, or reset default settings in all optimization windows. The optimization settings can be customized, saved, and loaded again during a different session.
Figure 2.2a. The new Save, Load, and Reset buttons in the Local Optimization window

The Save, Load, and Reset buttons appear in the Local Optimization, Global Optimization, and Hammer Optimization windows. The Save button saves the current settings to the OpticStudio configuration file. The Load button loads the last saved settings. The Reset button resets all settings to the defaults.

Note: The optimization windows remember the last setting you used in a session. If you change the optimization settings, run an optimization, and then close and reopen a window, the window will open with the last used settings. Any saved settings must be reloaded for use again.

The local, global, and hammer optimizers are located on the Optimize tab.

Figure 2.2b. The Optimize tab includes the local, global, and hammer optimizers

2.3 Plot auto-scaled field data (all editions)

Quickly define which distribution of field points adequately samples your field of view.

The Field Plot analysis in the Field Data Editor (FDE) is now auto-scaled to ensure that all defined field points are clearly visible.

Figure 2.3a. The Field Data Editor and the Field Plot analysis with a distribution of equal-area radial points
The default scaling of the Field Plot analysis is 1.1x the maximum field. The Field Data Editor and the Field Plot analysis are located on the Setup Tab in the Editors section.

![Figure 2.3b. The Setup tab includes the Field Data Editor](image)

### 2.4 Extract archive files to source folder (All Editions)

Extract OpticStudio files from a ZAR file and save them to the intended location in one step.

The Restore From Zemax Archive (ZAR) File window now includes a button to save the extracted files to the same location as the source file.

![Figure 2.4a. The Same as File button in the Restore From Zemax Archive (ZAR) File window](image)

Selecting Same as File sets the To Folder destination to the same parent folder of the source ZAR file. To open the Restore From Zemax Archive (ZAR) File window, click **Load Archive** on the **File** tab.

![Figure 2.4b. The File tab includes the Load Archive button](image)

### 2.5 Compare archive file contents (All Editions)

Share OpticStudio files with colleagues and easily identify changes.

The Restore From Zemax Archive (ZAR) File window now includes the Prompt if Different setting. This new file extraction setting compares the files in the ZAR file to the existing OpticStudio files.
The Prompt if Different setting is in the Restore From Zemax Archive (ZAR) File window. The Prompt if Different setting compares the files in the ZAR file to the existing OpticStudio files. If one of the new files is the same as an existing file, OpticStudio uses the existing file. If any of the files are different, OpticStudio prompts the user to choose between the new or existing file.

To open the Restore From Zemax Archive (ZAR) File window, click Load Archive on the File tab. (See Figure 2.4b.)

2.6 View ABCD Ray Transfer Matrix in the Prescription Data (All Editions)

Easily access the ABCD matrix representation of your optical system.

You can now access the calculated ABCD values of the ray transfer matrix in the General Data section of the Prescription Data report. In previous versions, the ABCD values could only be accessed on the Text tab of the Grid Distortion analysis.
The ABCD matrix values are calculated using the primary wavelength and on-axis field (x=y=0). The Prescription Data report can be accessed from the Analyze tab.

Figure 2.6b. Access the Prescription Data report from the Analyze tab

3 PROGRAMMING

3.1 RUN SEQUENTIAL TOOLS WITH THE ZOS-API (PROFESSIONAL AND PREMIUM EDITIONS)

Automate repetitive routines and create new alignment processes through the ZOS-API.

The ZOS-API can now call the sequential tools in OpticStudio to add and remove fold mirrors, reverse the elements in the Lens Data Editor (LDE), scale the system to a specific focal length, and simulate a double pass reflection.

Figure 3.1a. The sequential Lens Data Editor includes the Add Fold Mirror, Delete Fold Mirror, Reverse Elements, Make Focal, and Make Double Pass tools

All of the tools in the LDE are now available through the ZOS-API. The tools include:

- Add Fold Mirror
- Delete Fold Mirror
- Reverse Elements
- Make Focal
- Make Double Pass

The following are examples of the syntax for each tool.

Reverse Elements

- C#: IMessage ToolMessage = TheSystem.LDE.RunTool_ReverseElements(6, 9);
- **C++**: `ZOSAPI_Interfaces::IMessagePtr ToolMessage = TheSystem->LDE->RunTool_ReversElements(6, 9);
- **MATLAB**: `TheSystem.LDE.RunTool_ReversElements(6, 9)`
- **Python**: `TheSystem.LDE.RunTool_ReversElements(6, 9)`

**Add Fold Mirror**

- **C#**: `ToolMessage = TheSystem.LDE.RunTool_AddFoldMirror(4, ZOSAPI.Editors.LDE.TiltType.XTilt, 90);
- **C++**: `ToolMessage = TheSystem->LDE->RunTool_AddFoldMirror(4, TiltType::TiltType_XTilt, 90);
- **MATLAB**: `TheSystem.LDE.RunTool_AddFoldMirror(4,ZOSAPI.Editors.LDE.TiltType.XTilt, 90)`
- **Python**: `TheSystem.LDE.RunTool_AddFoldMirror(4, constants.TiltType_XTilt, 90)`

**Delete Fold Mirror**

- **C#**: `ToolMessage = TheSystem.LDE.RunTool_DeleteFoldMirror(5);
- **C++**: `ToolMessage = TheSystem->LDE->RunTool_DeleteFoldMirror(5);
- **MATLAB**: `TheSystem.LDE.RunTool_DeleteFoldMirror(5)`
- **Python**: `TheSystem.LDE.RunTool_DeleteFoldMirror(5)`

**Make Double Pass**

- **C#**: `ToolMessage = TheSystem.LDE.RunTool_MakeDoublePass(5);
- **C++**: `ToolMessage = TheSystem->LDE->RunTool_MakeDoublePass(5);
- **MATLAB**: `TheSystem.LDE.RunTool_MakeDoublePass(5)`
- **Python**: `TheSystem.LDE.RunTool_MakeDoublePass(5)`

**Make Focal**

- **C#**: `ToolMessage = TheSystem.LDE.RunTool_MakeFocal(100);
- **C++**: `ToolMessage = TheSystem->LDE->RunTool_MakeFocal(100);
- **MATLAB**: `TheSystem.LDE.RunTool_MakeFocal(100)`
- **Python**: `TheSystem.LDE.RunTool_MakeFocal(100)`

For more information about these tools, see the ZOS-API Syntax Help. (See Figure 1.3c.)

---

**Figure 3.1b. The ZOS-API Syntax Help dialog open to RunTool_DeleteFoldMirror()**
3.2 MODIFY PREFERENCES WITH THE ZOS-API (PROFESSIONAL AND PREMIUM EDITIONS)

Customize OpticStudio settings and preferences using the ZOS-API.

The ZOS-API can now modify many project preferences in OpticStudio. These settings are found on the Setup tab.

![Figure 3.2a. The General section of the Project Preferences dialog box.](image)

The Project Preferences methods in ZOS-API are:

- `General.DateTimeFormat`
- `General.Language`
- `General.ZMXFileEncoding`
- `General.TXTFileEncoding`
- `General.UseSessionFiles`
- `General.IncludeCalculatedDataInSession`
- `General.UpdateMostRecentlyUsedList`
- `General.UserPreferences`
- `ResetToDefaults()`

The following are examples for modifying project preferences through the ZOS-API.

**C#**

```csharp
IPreferences Preference = TheApplication.Preferences;
IPreferencesGeneral PrefG = Preference.General;
Console.WriteLine("DateTimeFormat: " + PrefG.DateTimeFormat);
Preference.ResetToDefaults();
PrefG.Language = ZOSAPI.Preferences.LanguageType.English;
```
C++:

IPreferencesPtr Preference = TheApplication->Preferences;
IPreferencesGeneralPtr PrefG = Preference->General;
// Define the enums to a map/dictionary
std::map<int, const char*> DateTimeFormatLookup;
DateTimeFormatLookup[DateTimeType::DateTimeType_None] = "None";
DateTimeFormatLookup[DateTimeType::DateTimeType_Date] = "Date";
DateTimeFormatLookup[DateTimeType::DateTimeType_DateTime] = "DateTime";
cout << "\nDateTimeFormat: " << DateTimeFormatLookup[PrefG->DateTimeFormat];
PrefG->DateTimeFormat = DateTimeType_None;

MATLAB:

Preference = TheApplication.Preferences;
PrefG = Preference.General;
Logic = {'False', 'True'};
fprintf('DateTimeFormat: %s\n', char(PrefG.DateTimeFormat))
Preference.ResetToDefaults();
PrefG.Language = ZOSAPI.Preferences.LanguageType.English;

Python:

Preference = TheApplication.Preferences
PrefG = Preference.General
Logic = ['False', 'True']
#Define the enums to a map/dictionary
DateTimeTypeLookup = {constants.DateTimeType_None:'None',
                     constants.DateTimeType_DateTime:'DateTime',
                     constants.DateTimeType_Date:'Date'}
print('DateTimeFormat: %s\n' %DateTimeTypeLookup[PrefG.DateTimeFormat])
Preference.ResetToDefaults()
PrefG.DateTimeFormat = constants.DateTimeType_None

More information about these tools is in the ZOS-API Syntax Help. (See Figure 1.3c.)

Figure 3.2b. The ZOS-API Syntax Help dialog box, open to General.DateTimeFormat
3.3 ACCESS MORE RAY DATA WITH THE ZRD READER (PROFESSIONAL AND PREMIUM EDITIONS)

Analyze more detailed ray trace results through the ZOS-API.

The Zemax Ray Database (ZRD) reader in the ZOS-API, called IZRDReader, can now access all ray trace information that is calculated in a non-sequential ray trace.

The following information can be called using IZRDReader:

- The ray status: terminated, reflected, refracted, scattered, diffracted, ghost, diffracted, surface scattered, or bulk scattered
- The number of ray segments
- The object number the ray intercepted
- The face number the ray intercepted
- The object number that the ray is propagating within
- The prior ray segment number
- The pixel number on a detector object that the ray struck
- The index of refraction of the media
- The initial optical path length
- The global coordinates of the ray intercept
- The global direction cosines of the ray
- The global normal vector of the object at the intercept point
- The physical (not optical) path length of the ray segment
- The optical phase path length added by the object
- The accumulated total optical phase of the ray
- The electric field in the global x, y, and z coordinates (real and imaginary parts)

You can find more information about these tools in the ZOS-API Syntax Help. (See Figure 1.3c.)
4 Libraries and Catalogs

4.1 Materials (All editions)

Get the latest materials catalogs from Sumita, APEL, Ohara, and AngstromLink.

The Sumita Materials Catalog has been updated to reflect the correct naming scheme. When the glass name starts with "K-," thermal coefficients are defined, and the effective range is extended to 0.36-1.55 um. When the glass name ends with "(M)," the dispersion equation is given after molding.

![Figure 4.1a. The Sumita Materials Catalog](image)

The APEL Materials Catalog has been updated to include three new grades: APL5014CL, APL5015AL, and APL5014GH.

![Figure 4.1b. The APEL Materials Catalog](image)
The Ohara Materials Catalog has been updated to include a new material, S-LAH63Q. The transmission of L-BAL42 is now defined from 0.24-2.4um.

Figure 4.1c. The Ohara Materials Catalog

The AngstromLink Materials Catalog has been consolidated with the Materials Catalog from Osaka Gas Chemicals. This change is noted in the catalog comment, and all glasses are now set to obsolete.

Figure 4.1d. The AngstromLink Materials Catalog

You can access the materials catalogs from the Libraries tab.

Figure 4.1e. The Libraries tab with the Materials Catalog button
4.2 **COATINGS (ALL EDITIONS)**

Get the latest coatings from Macleod.

The Macleod coatings have been updated to remove the substrate layer. Previously, each coating had a substrate layer of 0 mm thickness, which had no effect.

**Figure 4.2a. The Essential Macleod coatings**

You can access the Macleod coatings and the coatings tools from the Libraries tab.

**Figure 4.2b. The Libraries tab includes the Coating Catalog button**

4.3 **IES SOURCE MODELS (PREMIUM EDITION)**

Get the latest IES Source Model Catalog from OSRAM.

The OSRAM IES Source Model Catalog was updated to include new LEDs and to remove discontinued products. The new catalog now contains 598 source models.

**Figure 4.3a. The OSRAM Source Model Catalog**
To download IES Source Models, use the Download IES Files tool on the Libraries tab.

![Image of Libraries tab with Download IES Files tool highlighted]

*Figure 4.3b. The Libraries tab includes the Download IES Files tool*

### 4.4 Radiant Source Models (Premium Edition)

*Get the latest Radiant Source Model Catalogs from Philips Lumileds Lighting Company and DOMINANT Opto Technologies.*

The Philips Lumileds Lighting Company Radiant Source Model (RSM) Catalog has been updated to include 77 new LUXEON type high power LEDs.

![Image of Philips Lumileds Lighting Company catalog]

*Figure 4.4a. The Philips Lumileds Lighting Company catalog*

The DOMINANT Opto Technologies RSM Catalog has been updated to reflect their current product line. The catalog now contains 53 Radiant source models.

![Image of DOMINANT Opto Technologies catalog]

*Figure 4.4b. The DOMINANT Opto Technologies catalog*
Seven OSRAM LEDs and the Vishay Intertechnology catalog were removed from the Radiant Source Models library because the information is no longer valid.

You can download Radiant source models from the Libraries tab.

![Figure 4.4c. The Libraries tab includes the Download Radiant Source Models tool](image)

### 4.5 Test plates (all editions)

**Get the latest test plate lists from Wavelength Opto-Electronic and Rainbow Research Optics.**

Wavelength Opto-Electronic removed the test plate list `wavelength_singapore.tpd` from the installer and added a new test plate list `Wavelength Opto-Electronics (SG).tpd`.

![Figure 4.5a. The Wavelength Opto-Electronic test plates](image)

Rainbow Research Optics removed the test plate list `Rainbow Research.tpd` from the installer and updated the test plate list `RROI.TestPlates.tpd`. 
You can access the test plate lists from the Libraries tab.

![Test Plate List]

**Figure 4.5b. The Rainbow Research Optics test plates**

**Figure 4.5c. The Libraries tab includes the Test Plate Lists button**

### 4.6 Stock Lenses (All Editions)

Get the latest lens catalog from Daheng Optics.

The Daheng Optics Lens Catalog has been updated with new lenses, and obsolete lenses were removed. The catalog now contains 302 lenses.

![Daheng Optics Stock Lenses]

**Figure 4.6a. The Daheng Optics stock lenses**
You can access the lens catalogs from the Libraries tab.

Figure 4.6b. The Libraries tab includes the Lens Catalog button

4.7 HARDWARE KEY DRIVERS (ALL EDITIONS)

Get the latest Sentinel hardware key drivers.

The Sentinel System Driver has been updated to version 7.6.0 and is now compatible with Windows Credential Guard and Device Guard. This only applies to those using a Black USB license. Find more information about the driver version in the Device Manager.

Figure 4.7a. The Universal Serial Bus controllers section of the Device Manager includes more information about the Sentinel System Driver

5 BUG FIXES

OpticStudio 18.1 includes the following improvements and fixes:

Tools

- **Optimizing** - The optimization algorithm has been improved to handle scenarios in which the optimizer is terminated in the middle of a cycle.
- **Tolerancing** - An issue has been corrected in which incorrect compensator statistics were shown in the Tolerance output for systems with multiple compensators.

Sequential surfaces and analyses

- **Optically Fabricated Hologram surface** - Variables are now defined differently when optimizing the Optically Fabricated Hologram (OFH) surface. OpticStudio no longer automatically includes all variables in the construction files as a part of the optimization of the OFH surface. Instead, you need to use the HLGV operand in the playback file to define which variables from the
construction files should be made variable during the optimization of the OFH. This enables you to completely control how the variables are used, such as using pickups to link variables in the construction files. To make it easier to configure the HLGV operands, a new Add Hologram Variables tool has been added to the Multiple Configuration Editor toolbar.

- **Wavefront Map analysis** – An issue that was introduced in OpticStudio 17.5 has been corrected: The RMS wavefront error calculated in the Wavefront Map analysis incorrectly used the same algorithm as the RMS vs. Field analysis.

- **Elliptical Grating surface** - The algorithm used to trace rays to the Elliptical Grating surface has been improved to better handle grazing incidence rays.

**Non-sequential analyses**

- **System Explorer** - An issue has been corrected in which the Maximum Nested/Touching Objects value used in calculations was twice the value displayed in the Non-Sequential section of the System Explorer. Any file saved in a previous version now displays the correct value in the System Explorer.

- **Detector Viewer analysis** - A minor error with calculation of the solid angle used by the Detector Rectangle has been corrected. This error only occurred when viewing angular (intensity) data in the Detector Viewer analysis, and when the detected intensity distribution had a large angular spread.

- **Paraxial Lens object** - OpticStudio now supports defining the Paraxial Lens object as a mirror in non-sequential mode.

**Programming**

- **Zemax Programming Language (ZPL)** - The LOADLENS keyword in ZPL no longer closes previously open analyses after it opens a new ZMX file that does not have an associated session file.

- **ZOS-API** - A typo in the boilerplate code for the MATLAB interactive extension has been fixed. Line 80 of the code used to incorrectly read MXException() and now reads MException().

## 6 Known Issues

OpticStudio 18.1 includes one known issue.

When checking out a network license seat for use offline, in certain conditions the license may be removed from the client computer when the computer is restarted.

**Applies to:** This may affect OpticStudio 17 and later, including 18.1.

**Resolution:** This issue was recently corrected by our license vendor. An update to resolve the problem will be included in the next version of OpticStudio. To resolve this issue before the next OpticStudio release, you can update the Sentinel LDK runtime on the OpticStudio client computer and the computer that hosts the soft key license. For more information, see the License Check Out section of the knowledgebase article, [How to Troubleshoot Softkey License Issues](#).